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LE-850 Instruction Manual
The LE-850 is a controller for use with servo rotary fly-knife cutters. It contains advanced features not
found on typical rotary cutting systems.

Features
The following features are available:

Cut modes –
 Timer - quartz crystal derived - 1,000-cps
 Encoder - Quadrature or Uni-direction.
 Product edge via an optical sensor. Offset is available.
 Cuff for corrugated sections with flat portions.
 Follower - electronic gear lock to Puller.
 Flywheel - blade spins continuously - length control by rotation speed.

Scale Factor – for setting imperial or metric lengths via an encoder.

Sequenced lengths - 4 Lengths are available for On-demand modes. Any combination can be
sequenced, i.e. length 1 followed by length 2 etc. Each length uses a separate Batch value. Lengths
can be turned on or off individually.

Auxiliary outputs – each length or batch of lengths can be made to operate auxiliary outputs
either immediately or after a time delay. Typically used for synchronising downstream sorting and
packing machinery. Lengths have a separate menu for choice of which outputs to operate.

Fast outputs - two outputs are built in to the LE-850 control for quick response requirements.
Dedicated for length use. Any length can operate these.
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Batch pre-warn – to notify when a Batch is near completion. A separate output and reset is
available. *

Batch Total – a counter that counts batches. A separate output and reset is available. *

All outputs can be individually reset by hardware connections. *

Puller control – for combination servo cutter / puller machines. *

Automatic Shut Down – to shut down the cutter and / or the puller on completion of Batch Total.

Automatic Puller Correction – “Scroll”, for automatic modification of servo puller speed to
correct product diameter. This requires an external scanner monitoring the product. *

Scrap Mode – for separating out-of-tolerance product as detected by an external scanner. This
requires an external scanner monitoring the product. The scrap product can be cut to a user-
defined length to differentiate it from good. When scrap product is seen the auxiliary outputs are
disabled. *

Recipes – [option] similar to files where all parameters (ingredients) can be saved bundled in one
place. Names of eight characters can be assigned to each of sixteen possible recipes.

RS-485 communications – [option] for virtual instrumentation all can be operated over the RS-
485 communications on a host computer.

* Most Auxiliary connections require an additional IO card.
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The Fascia
The fascia is a flat membrane consisting of two six
digit green LED displays, an In Use digit, a green
backlit LCD message center, LED status indicators
and operator tactile feel keypads.

Primarily the left-hand display is used to show the
Batch Count, and the right-hand display is used to
show the Length Count. These displays will show
other values and parameters when making changes.

The message center defaults to an eight-decade
counter for displaying total cuts. At other times it

provides messages, i.e. information about which parameter is being displayed in the Length / Preset
display.

There are many functions available in this control so special attention has been made to the layout.
Associated functions have been blocked together and will now be discussed.

Keys – in General
Each press of a keypad will cause a momentary beep to be heard from the built in buzzer. There is also a
tactile feel. Some keypads have no functions in certain modes, yet a beep will still indicate a response.
Keys that are machine dependent may not have functions for your machine so will not beep. Some keys
have a repeat function or access to a special function when the key is kept pressed.

Auxiliary Status Section
Each length or cuff and each batch can operate auxiliary
outputs. Four length / cuff and four batch outputs are
available. These outputs can be latched or timed, immediate
or delayed. There is a separate reset available for each and a
global reset that can disable all outputs simultaneously
(requires IO card).

The timers can be set via the Edit menu - see Edit menu
section. Delays range between zero and 20 seconds. Outputs range between zero and 5 seconds. Zero is
used to latch an output on.

In this section there are sixteen colored indicators. All delays are yellow, outputs are green, and an output
that is in a hardware reset state is red. The green and red lights are contained within the same indicator.
Very short durations below 10 milliseconds may not be seen due to the display refresh time.

Auxiliary outputs can be globally enabled or disabled using the Outputs On/Off key. Disabling
the outputs will switch off all delays and outputs that are currently operating and prevent further
operation. Individual disabling is possible by using hardware resets on a separate IO card.
Enabling auxiliary outputs means that this section will function when the machine is running, i.e.

available for program use.

The state alters with each key press. To show when outputs are enabled the light in the key will light. They
will then turn on as cuts and batches complete.
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LE-850 Fast Outputs

Length Auxiliary outputs 1 and 2 are provided within the controller. They are available on a tiny 3-pin
metal connector at the rear of the control. These outputs use opto-isolated components and have about
50mA of current capability. To operate larger currents or high voltage devices it is strongly recommended
that they be operated via solid-state relays as in the example above.

Batch / Batch Total Section
This section contains a six-digit display and three keys. The
display defaults to showing the current batch count (amount
of cuts made in the current batch).

This counter can be reset to zero by using the Reset key and it can be enabled or
disabled by using the Batch On/Off key.

Each completion of a batch increases the Batch Total counter. To see the contents of the Batch
Total press the Batch Total key. The value will show for 5 seconds. The Batch Total is a four-
digit counter. To differentiate it from the six-digit Batch Counter it is preceded by P- (which is
short for Packs). While the Batch Total value is being shown it may be reset to zero by the Reset

key.

The Batch Total count is compared to the Batch Total preset. When this value is reached the Batch Total
output will switch on and the indicator in the Batch Total key will light. The hardware reset on separate IO
card will disable this output if activated. It can also be used to cancel the output after it has set. The Batch
Total key resets this output. It does not reset to zero automatically so will continue beyond its preset.

Batch Total - Auto Power down Feature
The control can be set to shut down the cutter and / or the puller on completion of the Batch Total. This
facility is available in the Options menu after setting the Batch Total preset and will be described later.
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Cutter Status Section
This section contains two keys and ten indicators for
machine status.

This key is used to start the cutter. The guard input must be closed before start can be accepted.
Without it a “Guard Open” error will be displayed. The guard status light will be lit when the
guard is safe. The light inside the Cutter Start key will show when the cutter is running. The
motor light in the status indicator will also light.

This key is used to stop the cutter. Certain faults will also stop the cutter accompanied by a fault
message. The motor indicator will turn off a few seconds after Stop turns off.

A yellow light in this key will be lit if enabled from the Automatic Shutdown menu. When lit the cutter will
power down on completion of the Batch Total. This feature will be described in more detail later.

Cutter Status Indicators
Cut --------------- lit when a cut has been triggered.
Park--------------- lit when the park input is on.
Motor ------------- lit when the motor enable output is on.
Pump ------------- lit when the drive enable output is on.
Scrap ------------- this has two colors. It is red when the input is on and it is green when the feature

is switched on from the Options menu. Both lights on together appear yellow.
Guard------------- lit when the guard input is closed - safe to run.
Product ----------- lit when the product input turns on
Cuff--------------- for Cuff mode only, this lights briefly when a cuff is confirmed.
Encoder A ------- lit when the encoder-A input is on.
Encoder B-------- lit when the encoder-B input is on.

At certain encoder frequencies Encoder A and B lights may pulse, stay on or flicker erratically.
This is normal.
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Total / Message Section
This section contains a
Liquid Crystal Display
(LCD) and six keys. The
four set-up keys and
messages will be described
later. For now, the emphasis
is on the use for showing the
total cuts made. There are

eight-decades available for this purpose. A comma separates each thousand, i.e. ten million, three hundred
and sixteen thousand and eleven is shown as 10,316,011. This makes the display easier to read.

This key is used to enable or disable the total counter. The option changes with each key press.
When enabled the light in the key will be on and the counter can count cuts.

This key can be used to reset the count to zero.

Length / Presets Section
This section contains a six-digit display that
defaults to show the current count but can also
be used to display parameters and simple
messages. Seven keypads are in this section;
five of these keys are used for editing
parameters and will be described later in the
editing section. For now we will describe the
two keys at the left-hand side of the display in
association with the length counter.

This key is used to enable or disable cuts. The option changes with each key press. When enabled
the light in the key will be on. The Start indicator must also be on for cuts to occur - see Start
Cutter key.

This key can be used to restart the count. If the motor is enabled and in an on-demand mode it
will make a cut. A manual cut is considered a sample so will not be counted on either of the
Batch or Total counters. Auxiliary outputs do not respond to manual samples. Counting continues
at the next count edge following the reset so the next length will be correct. A test cut can be

made irrespective of the Cut On/Off setting. This key is also used when editing presets.
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Cut Mode Section
This section contains one key and six mode indicators.

Select is used to change the cut mode. There are six cut modes listed but some modes may not be
available for your particular machine due to system availability. Each press of this key selects the
next item available down the list. Modes that are not available will be skipped. Pressing this key
while at the last available item in the list will return to the first available mode at the top of the

list. Only one cut mode can be available at any given time.

During editing of parameters this key is disabled.

The new mode begins two seconds after it is selected.

Cut Modes
TIMER Counts milliseconds from internal quartz crystal source. When the count equals or

exceeds the length preset the blade will be operated to provide a single cut (360°). The
decimal point is shown to three decimal places for counter and presets -
seconds.milliseconds.

Length sequencing is possible.

ENCODER Counts signals from an Encoder connected to the Encoder A and B terminals. Typically,
the Encoder is used to measure distance. When the count reaches zero a cut is made.

The phase relationship of the Encoder is used to determine direction when set to
Quadrature mode. If only one channel is available the counter will use Uni-directional
mode. The single channel should be connected to input A with B left open.

The controller automatically detects the encoder type by observing the activity on the two
inputs. If it sees activity on the A input and none on the B the message window will
briefly display “Uni-directional Encoder”. A quadrature encoder will briefly issue a
“Quadrature Encoder” message. In Quadrature mode a count is made at each signal edge
of the A input which has the effect of providing two counts for each pulse. For example,
an encoder with 600 pulses per revolution will give 1,200 counts. These inputs can
handle frequencies up to 500KHz. Uni-direction mode uses only one edge of the A input
so 600ppr will equal 600 counts.

The counter and presets are ten decades each, consisting of four integer digits and six
decimal places (xxxx.xxxxxx). However, the display only shows the six most significant
decades (xxxx.xx). The lower decades are still registered. The upper six decades of the
encoder preset can be altered; the lower four decades are fixed at zero (xxxx.xx0000).
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The scale factor is aligned to the lower six decimal places (0.xxxxxx). The scale decimal
point cannot be seen.

Length sequencing is possible.

PRODUCT Provides a cut when the Product input is activated. Typically, an optical sensor is
positioned to detect the product edge downstream of the cutter. Alternatively, this signal
can be provided by another counting system or from a synchronising source.

A Hold-off timer is available to avoid double cutting caused by product bouncing in front
of the sensor or contact chatter from relay contacts. The input initiates a cut and begins
the Hold-Off timer. During the Hold-Off period the sensor is ignored. Hold-Off uses the
internal quartz crystal timing source. The value entered is in milliseconds and must be set
less than the time expected between cuts so that it is ready for the next edge, i.e. 70 to
80% of the length. The decimal point is shown to three decimal places for both count and
preset - seconds.milliseconds.

An offset preset is also available which appears after entering Hold-Off. If an immediate
cut is required simply set this to zero.

CUFF This is a special mode that uses the Encoder and Product inputs together. In this mode the
product input has to change to a defined logic level and remain at that level for a distance
longer than has been preset. Typically, this combination would occur from corrugated
tubing that has flat sections, or material that includes a marker.

Once this criteria has been met the cuff will be confirmed to the operator by a short flash
of the cuff indicator (machine status section). Between one and three cuts can be
synchronised from this cuff. As with Product mode a Hold-off is available. Hold-off
differs slightly from product mode as it uses distance rather than time. The search for the
next cuff is disabled until the Hold-off distance completes.

Sequencing is available.

FOLLOWER Is available for FX style servo cutters that have a PCM-15 personality module fitted. In
this mode the length entered is passed to the servo drive. The amount of blades that are
fitted to the cut wheel can also be entered. The drive then uses this information along
with information provided by the puller to lock the blade rpm to the puller speed. This is
an electronic version of a gear lock. The length display will show the word “Slave”
because the cutter is the slave part of a master/slave system. The puller is the master.

FLYWHEEL Typically, this mode is used for short lengths where the motor continuously rotates. The
length is set by line and blade speed. The park sensor continues to be used to count cuts
and a blade quantity preset is available for multiple blade applications. Length presets
cannot be set in this mode so the display shows "FLY" meaning it is cutting using the
Flywheel method.
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Length / Cuff in Use Section
This section consists of a single digit, a key and four indicators.

The four indicators are used to show which lengths / cuffs are
enabled. Enabling and disabling lengths is made through the edit
menu.

The digit is used to display which length / cuff is currently in use. As there are four possible lengths / cuffs
available this digit can only show numbers one through four. As a batch of lengths or a cuff is completed
the next available length / cuff will be selected.

This key can be used to manually select the next length / cuff rather than having to wait for
automatic switch over.

For Product, Follower and Flywheel modes length 1 only is available all other lengths are disabled.

Timer and Encoder modes switch automatically to the next available length after the current batch of
lengths is complete.

Cuff mode will switch to the next available cuff when the current cuff is complete.

If only one length / cuff is enabled the same length / cuff will repeat.

It is possible to switch off all lengths / cuffs through the edit screens. The length / cuff in use will then
continue using the last preset that it had been processing.
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Puller and Blade Speed Section
These five keys are for Servo machines. The block of four keys are for
combination cutter / pullers when they are enabled.

This key is used to set the blade quantity in Follower and Flywheel modes and blade speed in
every other mode. When this key is first pressed the light in the key turns on and the preset will
appear in the Length / Presets display. The message window will show the name of this
parameter. The value can then be altered as required using the edit keys. Entering a new value or

pressing the Blade Speed key again will enter the value. The light in the key will turn off and shortly
afterwards the displays will return to their default uses.

This key is used to set the puller speed. When this key is first pressed the light in the key will
switch on and the preset will appear in the Length / Presets display. The message window will
show the name of this parameter. The value can then be altered as required using the edit keys.
Entering a new value or pressing the Puller Speed key again will enter the value. The light in the

key will turn off and shortly afterwards the displays will return to their default uses.

It is possible for the Puller speed to be modified externally using Scroll inputs. This key is used to
enable or disable this function. The ability to scroll alters with each key press. When enabled the
light in the key will be on. Typically, the scroll feature would be turned off while setting up the
line and would be enabled once the product dimensions have stabilised.

This key is used to start the puller. When enabled the light in the key will switch on.

This key is used to stop the puller. The light in the Start Puller switch will turn off. A light in this
key can be lit by enabling it from the Options - Automatic Shutdown menu. This feature will be
described later.
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Setup Section
This section contains four keys. They are used with the LCD Message center,
Preset display and edit keys (Set and arrow keys) to access menu items and
parameters.

There are many parameters available. To assist in finding the right parameter
each is named and grouped in easy to find sub menus.

This key is used to access the edit menu. The first time that it is pressed the light in the key will
switch on. The first line of the Message center will change to read “Edit Presets”. The second line
will read the first menu option available for the current cut mode. Pressing this key again at any
time will cancel the edit menu without making changes and the light in the key will turn off.

This key is used to access the file menu. This is an optional feature. The first time that it is
pressed the light in the key will switch on. The first line of the Message center will change to read
“File Menu”, the second line will read “Load File ?”. Two options are available in this menu,
Load File or Save File. Pressing this key again at any time will cancel the file menu without

making changes and the light in the key will turn off.

These keys are used while editing to accept or decline an option or preset. At all
other times these keys have no functions. Most menu items will include a question
mark at the end. For example “Load File ?”. When this occurs, a yes or no response
from the operator is expected. For example, you either want to load a file or you do

not.

Yes, accepts the option shown. If this is a parameter it is placed in the edit window for editing. If there is a
sub heading or further question then that will be shown.

No, is used to reject the option shown. The next item or question down the list then appears. Mostly, this
key has a very similar function to the down arrow key.

The functions repeat if kept pressed.
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Edit Keys
There are six keys in this section. These include the
Reset / Test, Set, Up, Down, Left and Right.

When setting a file name the Message center is used to show the name as it can show text and
numeric characters. The reset key is used to clear the name. Eight spaces (blanks) are shown after
it is reset.

When a parameter is being shown in the Length / Presets display this key can be used to reset it to zero. A
parameter appears with one of its digits flashing.

When choosing items from the Edit menu this key is used to move up the list of options. While
the first item in the list is showing this key will choose the last item in the list.

When setting a file name this key scrolls the underlined character up through the available
characters. Letters A to Z, numbers 0 to 9 and space (blank) characters are available.

When a parameter is being shown in the Length / Presets display this key is used to increase the digit which
is flashing. The number is increased from zero to nine and back to zero again.

When choosing items from the Edit menu this key is used to move down the list of options.
While the last item in the list is showing this key will choose the first item in the list.

When setting a file name this key scrolls the underlined character down through the available characters.
Letters A to Z, numbers 0 to 9 and space (blank) character are available.

When a parameter is being shown in the Length / Presets display this key is used to decrease the digit
which is flashing. The number is decreased from nine to zero and back to nine again.

When setting a file name or parameter this key selects the highlighted character to the left of the
character that is presently highlighted. While the first character is highlighted pressing this key
will select the last character. Characters are highlighted in a filename by an underline.
Highlighted characters in a preset flash on and off.

This is similar to the Left key but moves the highlight towards the right.
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Set

When a parameter has been modified there are two choices available; 1- Use the new value, or 2-
keep the old value. Pressing this key accepts the new value. To cancel the changes any one of the
edit keys can be pressed (Edit, File, Blade Speed or Puller Speed).

Menu Structure
Most parameters are set using the Edit Menu. Parameters (presets) are logically grouped so that finding a
parameter and changing it is only a matter of a few keystrokes. Edit Menu key is used to access the menu
and may be used a second time to leave items unchanged. Set key is used to accept a change.
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Editing Presets and Menu Structure
This section shows examples of how to change a parameter.

Example 1 (in Timer mode) Set length 1 for 2.5-second cut intervals. There is no need to shutdown the
motor prior to changing parameters.

Press the Edit Menu key. The light in the key will
illuminate. The message display shows:

The symbols ^ and ? are used to point the operator to the expected responses. The ^ symbol means that the
up and down keys may be used to move up and down through the menu list. The ? symbol means that Yes
or No can be used. The first parameter option is Length and this is what we require.

Press the Yes key. For this example length 1 preset is to be
adjusted so answer yes. There are four lengths available in
this mode so the message display will change to show:

Press the Yes key again. Length 1 is the first choice and the
preset that we wish to change. The Length/Presets display will
now show the previous preset value with one of the digits
flashing. The flashing digit can be increased or decreased by

using the up and down arrow keys. The left and right arrow keys are used to select the digits either side of
the flashing digit. They in turn will begin to flash.

Try experimenting with the four arrow keys to become familiar with their uses. In addition, note how they
wrap around, i.e. numbers will rollover from 0 to 9 and vice-versa when using the up and down arrow keys;
edit digits will roll around from the left-most to the right-most digit and vice-versa when using the left and
right arrow keys.

Press the Reset/Test key. The preset will change to show 000.000. Reset is useful when setting a
new number as it wipes the slate clean. When making slight modifications to a previous number
the reset may not be required.

Press the left and/or right arrow keys to select the
seconds’ digit (third from left).
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Press the up arrow key twice to change the value to 2 seconds.

Press the right arrow key. This selects the 1/10th-second digit.

Press the up arrow key five times to change this value to 5. The
down arrow key would achieve the same due to the wrap around
feature. The display now shows the required preset value -
002.500 (2.5–seconds).

Press the Set key. The light in the Edit Menu key will turn off and the display will continue to
show the preset for a short while longer. Eventually, the displays will revert to their default uses,
i.e. to show counts in progress. Editing of this preset has now been completed.

Made a Mistake?
If a mistake is made during editing the easiest way out is to press the Edit Menu key again to disable the
function. A parameter is not changed until the Set key is pressed. Pressing the Edit Menu key or any other
functioning edit keys (File Menu, Blade Speed or Puller Speed) while processing a preset will leave the
preset as it was.

Another Example (Example 2)
This time we will set Batch 1. Batch 1 is used to define how many pieces of Length 1 there are per bundle.
The Batch counter for this application will not operate any auxiliary outputs. It is a fairly slow line speed
operation and the operator can handle the cut pieces comfortably. The Batch counter will count up towards
50 but 50 will never be shown, as the 50th piece will reset the counter to zero, i.e. 48…49…0.

The operator has cartons to prepare while keeping a check of the product and must maintain hopper
contents. This means that the operator will not always be ready as the 50th piece gets cut. This does not
matter too much because the count restarts.

As the operator gets back to the machine a batch has obviously been completed and the count has just
changed to 3. This simply is interpreted as one batch plus three pieces from the next batch. The bundle can
be collected and the excess pieces put back.

Press the Edit Menu key. The light in the key will
illuminate. The message display shows:

Press the No (or down) key.
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Trim Press the No (or down) key

Press the Yes key

Press the Yes key

Press the Reset/Test key. This will zero Batch preset 1.

Press the left and/or right arrow keys to highlight the
tens digit.

Press the up arrow key five times to change this value to 5.

Press the Set key. This preset has now been changed to 50.
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Length Delay

n Set Outputs...

Menu List
The previous examples show how to change two of the available presets. Most other parameters are
modified in the same way. Use the Menu Structure list pages to help locate parameters until you become
familiar with the layout.

Menu List - Timer and Encoder modes
The following pages are used to explain parameters in more detail. Timer and Encoder modes have a
similar menu structure while other modes will have a variation of the following.

Length
This sets the Length between cuts. In Timer mode the value is in seconds to three decimal places
(milliseconds). In Encoder mode the value is distance. One or two decimal places may be set. This is
chosen when setting the scale factor.

Length Menu - Select
This preset is used to choose which lengths to use. The preset uses the lower four digits of the six-digit
preset display (the upper two digits are always 00). The edit keys can be used to choose a digit but each
digit can only take on one of two values. For example, the third digit from the left can be a zero or a one.
When one is showing it means that length 1 is enabled. The next digit to the right can be a zero or a two.
The other digits can be 0/3 and 0/4. All four lengths or any combination can be enabled.

Length Menu - Delay
Each length has an associated auxiliary delay. The delays are used to operate auxiliary outputs after the cut,
i.e. for length sorting. The value is in seconds to three decimal places. A range of zero to 20.000-seconds is
available. Zero means that an output(s) will operate immediately.

Each delay can be used to turn on any combination of length outputs. After entering a delay a further
question is asked…

The Set Outputs preset operates in the same way as Select shown above. Use it to choose which outputs
will operate at the end of this delay. The first two outputs are available as Fast Outputs on the rear of the
LE-850. All other outputs require an IO card. Timing of these other channels will be affected slightly by
communications delays.

Length Menu - Output
When an auxiliary length output is used its duration 'On' time can be defined. The range is zero to 5.000-
seconds. Zero has a unique use in that it latches an output on.
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0 
or 
1

0 
or 
2

0 
or 
3

0 
or 
4
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Shutdown

Cutter?

Shutdown
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Batch
Use this to set the amount of pieces required per batch. If other lengths are enabled this value will also be
used to switch to the next preset, i.e. if batch 1 is set to 50 on the 50th piece the control will switch over to
the next available length.

Batch Menu - Delay
Similar to lengths an output can be operated upon each batch completion. Batch delays differ slightly to
Length delays in that they are dedicated to one output, i.e. the same number value.

Example - Length 1 makes a cut and the Batch counter increases by one. When Batch 1 completes it resets
(switches over to next length if another is enabled) and starts Batch Delay 1. Batch Delay 1 completing
turns on Batch Output 1 and the output remains energised for the time set in Batch Output 1.

Batch Menu - Output
This sets the time that the auxiliary Batch Output remains on. Zero is used to latch an output on. An IO card
is required for auxiliary batch outputs.

Batch Menu - Warn
This can be used to warn the operator that the batch is almost finished. All four warn presets operate the
same output. Typically, this output would be used to operate an alarm. An IO card is required for batch
warn output.

Batch Menu - Total
This sets the amount of batches that are required before the control should shut down. Automatic
shutdowns are available from this preset for cutter and puller. They should be set as required after changing
the preset. A separate batch total output is also available. An IO card is required for this. The Batch Total
Output may be used without shutdown when setting both options to off (choose no).

The LE-850 control expects Yes or No answers in response to the above two questions. When choosing
Yes a yellow light in the associated Stop key illuminates. This indicates that it will shutdown (stop) on
batch total completion. Batch total must be manually reset.

Option Menu - Scale Factor
This is used to calibrate the Encoder to the required scaling units. A simple Yes / No question is asked first
in order to set the decimal place. Yes chooses two decimal places and no chooses one. This sets the decimal
place for the Length counter and presets - scale does not show any decimal places.

After the decimal place option a value may be set that relates to the increment size given by the encoder. If
the encoder is a quadrature style it will be necessary to set a scale factor half the size of the pulse width
size. This is because the control uses the quadrature x 2 method (counts each edge on the A-channel).

Scale Factor is shown without any decimal places. It is less than one when two decimal places are chosen,
i.e. 0.XXXXXX. For the one decimal place option the scale factor value is X.XXXXX.

Example - A quadrature Encoder is being used that has a 12" circumference wheel and provides 6,000
pulses per revolution on each of the A and B channels. The LE-850 will count 12,000 times per revolution
since it uses quadrature x 2 mode. Each count has a value of 0.001". Set the scale factor to 001000 when
using the two decimal place option. Use 000100 for the one decimal place option. An invisible decimal
place is after the first zero with this option (read this as 0.00100).
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Option Menu - Repeatability
When the cutter is making cuts it is possible to check accuracy. This method makes use of a time stamp
feature that is inherent in the microcontroller. In most cases two values are shown. These are known as Cut
to Cut and Cut to Park. The values displayed are in microseconds. They show peak variance in cut to cut
and cut to park times.

The first Cut to Cut and Cut to Park times are used to establish a reference. The display will initially show
Repeatability - Test in Progress. Further Cut to Cut and Cut to Park times are then compared to the initial
reference. The values shown are the difference between the highest and lowest times. As new worse case
values arrive this number will grow.

Use this to determine problems with the cutter or the line. In time mode the Cut to Cut value should be
fairly tight as the cut trigger is generated from the same clock. However, in Encoder mode this value will
be larger and shows how much the line is varying.

Flywheel mode shows a Park to Park variance value. Repeatability is not available while the control is
stopped.

Option Menu - RS-485 Address
If RS-485 communications is installed this menu item will appear so that a unique address may be assigned
to the LE-850 control. Any address between 00 and 99 may be used although 00 should be avoided as
many protocols use this address for broadcast messages. The default address is 85.

Terminal A is the non inverting input / output, and terminal B is the inverting input / output.

The LE-850 Controller uses the following technique for serial communications :-

RS485 Multi Drop Ansi-X3.28-2.5-A4
Baud Rate - 9600
Format - 1 start, 7 data, 1 even parity, 1 stop
Address - 00 to 99 (default is 85)

(00 is normally reserved so should be avoided).
(See section on Address Changing).

Officially, the standard allows for 32 drivers and 32 receivers using a maximum cable length of 4,000feet
(1,200 meters). Ideally, a shorter cable length will be used because of the typical noisy environment. The
communications device uses a reduced slew rate driver to minimize EMI (required for CE), and reduce
reflections caused by improperly terminated cables. This does not affect our data transmission rates as it is
good for data rates up to 250kbps, as opposed to the possible 2.5Mbps of the standard RS485. The driver is
short circuit protected.

To minimize reflections, the line should be terminated at both ends in its characteristic impedance, and stub
lengths should be kept as short as possible. The total expected load for RS485 is 60R, usually made up of a
120R resistor at each end of the line. A 120R resistor is already fitted to the LE-850 controller with one end
connected to the B terminal, with the other end of the resistor brought out to the A Load terminal. This may
be linked to the A terminal if the termination load is required.

Option Menu - Scrap mode
This option allows a different length to be cut when the product is out of tolerance. This ensures that bad
product does not get mixed in with good. A laser scanner and IO card are required for this feature. While
the product is out of tolerance auxiliary outputs do not operate.
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Option Menu - Puller Setup
This option appears on the LE-850 when puller control is available. A maximum and minimum speed may
defined. Puller Speed will then be limited by these two values. Ensure that maximum is always greater than
minimum.

A scroll step may also be set. This may be used with a laser scanner and IO card to step the puller preset
speed up or down within the limits.

Option Menu - Product +/-
This option allows the product edge to be set for Product and Cuff modes. A simple yes/no question is
asked to set the logic. Example - an eye sensor is used that turns on an output when the product breaks the
light beam. The output pulls to zero volts when the beam is broken. For this sensor set negative edge.
Another sensor is then used but it turns off when the beam is broken. For this sensor set the positive edge
option.

Option Menu - Default All
This option may be used to return all parameters back to their factory default states. An "ARE YOU
SURE?" warning appears. Choose Yes if you want to go ahead or use No or Edit Menu again to quit.

Option Menu - Checksum
Checksum is shown automatically at power up. It can be viewed again through this option. Checksum is
unique to the program contents of the EPROM. The value is a four digit hexadecimal sum of the entire
EPROM.

Menu List - Product Mode
In product mode a cut is usually made by an eye sensor mounted downsteam of the cutter that is connected
to the product input. The source can alternatively be from another control system. In this mode the length is
fixed by this input so multiple lengths are not available.

A Hold-off value can be set. This is used to disable the sensor once the product has been detected and cut
initiated. This value protects against double triggering caused by the product that can bounce in front of the
sensor after it has been cut. It will also protect against double cutting from contact closure sources, i.e.
relay contacts. When the Hold-off time finishes the sensor becomes active again.

Hold-off time should be set to 75 to 80% of the expected time between cuts so that it is ready for the next
cut.

After setting Hold-off time a further preset may be set called offset. When set to zero a cut occurs
immediately. However, if a value is set here the cut can be time delayed.

Start and Cut On/Off provide an automatic cut at start up.
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Menu List - Cuff Mode
This special mode uses a different kind of menu structure. If this mode is not available for your control
Select key will simply skip to the next available mode.

Cuff mode is available for corrugated sections that have flatted sections (cuffs), but can also be used to
synchronise to products that are ink marked or punched upstream of the cutter. An optical sensor and an
encoder are used together to provide a product signature recognition system like the image that would be
seen on an oscilloscope. There are six values associated with each cuff and four cuffs that can be set.

1. First Cut (offset)
2. Second Cut optional - set to zero to turn off
3. Third Cut optional - set to zero to turn off
4 and 5. Cuff shape (sensor logic level plus length)
6. Hold-off

Setting a Cuff
In this example a high cuff of 2.2-inches long needs to be cut in the center. Just one cut is required. This
sequence repeats every 20-inches.

Press the Edit Menu key. The light in the key will
illuminate. The message display shows:

The symbols ^ and ? are used to point the operator to the expected responses. The ^ symbol means that the
up and down keys may be used to move up and down through the menu list. The ? symbol means that Yes
or No can be used. The first parameter option is Cuff Details and this is what we require.

Press the Yes key. For this example Cuff 1 is to be set so
answer yes. There are four cuffs available so the message
display will change to show: Up and down keys may be
used to select one of the other cuffs.

Press the Yes key. This preset is also known as Offset. It
appears at the top of the list because it is used regularly
when positioning the first cut. The previous cut 1 (offset)
value will appear in the preset display for editing.

The value is affected by line speed, blade park position and position of the photo eye in respect to the
cutter. Initially, start with a small value and then increase later to get the cut in the correct position. For
now use the edit keys to set this to 0.2". This preset will be readjusted last.

Press the Set key when done. A second cut may occur after
the first cut if it is required. Cut 2 is referenced to the first
cut. If not required simply enter zero for this preset. In this
example we do not want a second cut so enter zero.
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Press the Set key. If a value had been entered for cut 2 then
an option will be given to set a third cut.

The preset that now shows is in fact two presets in one. The first character
is used to set the logic level of the cuff (high or low). Use Option Menu -
Product to set this so that high means a wide cuff (beam broken) and low
means a small cuff (beam open).

The last four digits are used to define the cuff confirmation length. A cuff is confirmed when the logic level
is maintained for longer than the length set. This allows smaller corrugations to be ignored. Example - the
corrugations are 1/4" apart but the cuff is 2.2" wide. We need to set a value that is in between these two so
that the two distances can be differentiated. A value of 1/2" to 2" should suffice. In the example above we
have set 1-1/4". Cuts are synchronised from the initial (high) edge and not the confirmation distance so any
reasonable distance will do. Set a value that is long enough to avoid false triggering. If possible, set at least
twice the corrugation spacing.

Press the Set key. Once a cuff has been detected there is no
need to be looking for the next cuff as it is twenty inches
away. The sensor can therefore be switched off to prevent
false triggering. This preset is very similar to the Hold-off

used in product mode except that distance is used rather than time. The Hold-off should be set slightly
lower than the cuff spacing so that the sensor can wake up in time for the next cuff. For this example it will
be set to eighteen inches.

Press the Set key. This cuff has now been set and Edit Presets turns off. However, the cut will
still need adjusting. Go back to the Cut 1 length to adjust the cut position as required. Before
doing this it is recommended that the error is first measured. For example, we originally set 0.2"
but it is cutting 2.55" too soon. Change the Cut 1 value to 2.75" (2.55" + 0.2").

Press the Set key. The second cut distance preset appears again. Since Cut 1 was the only preset
that was being changed it is now safe to quit from Edit Presets mode.

Press the Edit Menu key. The light in the key will turn off and this mode ends.

Batch and total count the first and third cuts in three cut applications. The second cut is usually used for a
scrap length so it is ignored.

Cuff Menu - Select
Cuffs can be turned on or off using the Cuff Menu - Select option. This works in the same manner as the
select feature for Timer and Encoder modes.

Cuff Mode Auxiliary Outputs
In this mode Cuff is used to activate the auxiliary delays that turn on the auxiliary outputs.
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Menu List - Follower Mode
This mode is available for Servo Machines that have Follower ability. One length and blade quantity can be
set. The values are transferred to the drive and the drive then performs a gear lock function. Auxiliary
outputs are not available. Blade Quantity is set using the Blade Speed key.

Menu List - Flywheel Mode
In this mode the blade runs continuously. Auxiliary outputs are not available. Blade Speed is used to set
Blade Speed and Blade Quantity. The Blade Quantity option is only available while the control is stopped.

File Menu (recipes)
Recipe is an optional installation. When not available pressing the key will display a Function not available
message.

Load File or Save File are the two possibilities. Use with caution as they move data and overwrite existing
data in much the same way as files in a personal computer.

Sixteen locations are available which can hold all user variables. The current operator settings, known as
the work-page can be saved to any of the sixteen locations. These locations are fixed in size and numbered.
To assist the operator these files can be saved with meaningful names of up to eight alphanumeric
characters.

When saving be aware of the possibility of overwriting an existing used location. This is where the
alphanumeric names are useful.

When loading a file to the work-page do so with caution. If the current work-page as not yet been saved do
so before loaded another file.

During the loading process the LE-850 will ask “ARE YOU SURE?” before overwriting the current work-
page. Yes will overwrite; no will cancel.

During saving the LE-850 will ask “FILENAME OK?” before saving. Yes will save the file with the
displayed name to the location specified; no will offer the option to change the name. It is recommended
that filenames be used although this is not necessary as the locations are numbered.
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Auxiliary Outputs Example - Product Sorting
Auxiliary outputs allow cut pieces to be sorted. Length/Cuff and Batch can be used to operate outputs.
Most applications use one length.

For example, an order for one million 6-inch pieces of product XYZ has been received. These pieces are to
be boxed 500 per carton. The pieces may free-fall into the box and will be assisted by a puff of air on a
take-off conveyor table so that the pieces drop in the right place. Two positions (zones) are going to be
used so that one carton can be sealed while the other is being filled.

For this application two presets and two auxiliary outputs are going to be used. Auxiliary outputs are being
used to operate pneumatic valves. An Encoder is available so Encoder mode is selected.

Lengths 1 and 2 are set to 6-inches and turned on from the Length Menu - Select
Batches 1 and 2 are set to 500 pieces.
Outputs 1 and 2 are set to 50-milliseconds. This is long enough to blow the product into the box.
Delay 1 is set to 2-seconds so that the pieces just clear the outgoing bush before being blown into the box.
It is set to operate output 1.
Delay 2 is set to 5-seconds so that the pieces can fall into the second box. It is set to operate output 2.
Batch Total is set to 2,000 with its output connected to an alarm to indicate when the 2,000 boxes of 500
(1-million) are complete. The power down feature is not selected.

Quality Checking
From the previous example it can be seen that the system could easily be modified to provide samples for
quality checking. For example, the system could be made to cut 100 pieces, which drop in zone 1, then
make one sample piece (of any size) and send this to zone 2. In the example above where we are using two
drop zones, a third preset could be used for the sample with no eject so that it travels to the end of the take-
off.


